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Chapter 1 - Enhancements

This chapter presents a high-level description of the following enhancements to the CGM 
MEDISOFT® system. 

Prior to Upgrading
CGM recommends that you always install successive versions of the software when upgrading to 
ensure proper registration and data conversion.

For example, if you are currently on version 25 and are upgrading to 27, be sure to upgrade to 
26 FIRST, register and convert your practice data. Then, from version 26 upgrade to 27.

IMPORTANT; If you send appointments to CGM CONNCTION, read this BEFORE upgrading for 
actions you may need to take before you upgrade. 

Please review the instructions here before upgrading: “Updated Data Transfer to CGM 
CONNECTION” on page 28.

Features to set up prior to using CGM MEDISOFT 27
The features in the table below require setup prior to using CGM MEDISOFT 27.

Feature Setup to do

Patient Alerts 1. Set up Permissions

2. Create alerts

3. Assign alerts to patients

Merge Patients  • Set up Permissions

Move Charges 1. Set up Permissions

2. Add MoveCharges field to available grid 
columns on the Transaction Entry screen

CCRD (Co-Pay, Co-Insurance, and 
Remaining Deductible Results from 
eMEDIX)

If you do not use eMEDIX as your 
clearinghouse, you may skip this step.

1. Enter preferred Service Type Codes on the 
Data Entry tab of Program Options.

Be sure to put the codes in preferred order 
BEGINNING with Code 1. Do NOT leave Code 
1 blank and fill in the others. 
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Desktop display
There is a new hover-over for the practice name when the practice is minimized on the desktop. 
This will allow you to quickly see which practice is open.

Figure 1.  Hover-over on practice

Patient Alerts
You can now create Patient "Alert Codes," which can be assigned to a patient from the patient 
level. 

Each patient can have up to five Patient Alert Codes assigned to them, as well as one free-text 
alert. These alert codes are user-defined and user-created and can be assigned in the patient 
record. The Patient Alert Codes can be used as warning messages to the practice, assigning a 
status, as a reminder to the practice, categorize the patient into a group, and so on. 

You can set up alerts to open on one or up to four screens in CGM MEDISOFT, based on 
selections you make when creating the alert:

 • If the Display on New/Edit Transaction Entry is checked, a pop-up window will open with the 
alert(s)  when the user creates or edits a transaction for the patient. The alerts will display 
immediately after the patient is selected.

 • If the Display on New/Edit Patient is checked, a pop-up window will appear with the alert(s) 
when the user creates or edits a patient. The alerts will display immediately after the patient is 
selected.

 • If the Display on New/Edit Case is checked, a pop-up window will appear with the alert(s) 
when the user creates or edits a case for the patient. The alerts will display immediately after a 
case is selected.

 • If the Display on New/Edit Appointment in Office Hours is checked, a pop-up window will open 
with the alert(s) when the patient is selected on a new or edited appointment in Office Hours. 
The alerts will display immediately after the patient is selected.

Free text alert will display on all of the above. 

If multiple Patient Alert Codes are chosen for a patient and that patient is chosen in one or more of 
the four optional pop-up areas of CGM MEDISOFT, all selected messages will appear in one 
window.
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New Permission
There is a new Permission for the Patient Alert Codes List: Patient Alert Codes. Use this to set the 
access levels for Patient Alert Codes.

Figure 2.  CGM MEDISOFT Security Permissions
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New Menu item
There is a new item on the Lists menu: Patient Alert Codes. Select this option to open the Patient 
Alert Codes List screen.

Figure 3.  List menu

New Patient Alerts list
Use this window to view, search for, and filter alerts that have been created. Use it also to create, 
edit, and delete existing alerts.

Figure 4.  Patient Alerts List screen
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The table below describes the elements on this screen.

New Patient Alert Code Entry
Use this screen to create and edit alerts. You can give the alert a description and specify on which 
areas of CGM MEDISOFT you want the description/message to open.

Figure 5.  Patient Alert Entry screen

Elements Description

Search for Enter a Code to search for. As you type 
characters, the grid will automatically filter. 

? button Click to open the Locate Patient Alert screen, 
which you can use for advanced searching.

Field Select the type of data to search for, either Code 
or Description

grid This shows you the list of codes. 

Note that in the Description column, you will only 
see the first line of an Alert Codes that have 
multiple lines in their Description fields.

Edit button Click this button to edit a selected alert in the grid.

New button Click this button to create a new alert.

Delete button Click this button to delete a selected alert in the 
grid.

Print Grid button Click this button to print the information in the grid.

Close button Click this button to close the List screen.
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Updated Patient - Other Information tab Chapter 1 - Enhancements

The table below describes the elements on this screen.

Updated Patient - Other Information tab
The Other Information tab of the Patient screen now includes fields for up to five Patient Alert 
codes and one Free Text alert. Use these fields to select the codes or enter free text that you want 
to display when the patient is selected in the designated areas.

Figure 6.  Patient screen - Other Information tab

Element Description

Code 1 Use this field to enter a code for the alert, up to 9 
characters.

Inactive Select this check box to mark the alert as 
inactive.

Description Use this field to enter a description of the code. 
This information will appear on the Alert Popup 
when it is triggered on one of the 4 screens. 

This field can be up to 70 characters.

Display on new/edit Appointment in Office 
Hours

Select this check box if you want this alert to 
display when a patient is selected in Office Hours 
appointments.

Display on new/edit Transaction Entry Select this check box if you want this alert to 
display when a patient is selected in Transaction 
Entry.

Display when editing Patient Record Select this check box if you want this alert to 
display when the patient’s record is opened.

Display on new/edit Case Select this check box if you want this alert to 
display when the patient is selected for the case.

Save button Click this button to save the new alert or the 
changes for an edited alert.

Cancel Click this button to close the window without 
saving the alert or changes to an alert.

Help Click this button to open the Help for this screen.
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Chapter 1 - Enhancements Updated Patient - Other Information tab

In addition, there is an optional sixth, user-defined alert that is specific to that patient.

The drop-down arrow to the right of the Patient Alert Code field will display the list of existing alerts, 
as well as the settings of the check boxes for that alert.

Figure 7.  Other Information tab - Patient Alert Codes section

Clicking the magnifying glass to the right of the Alert Code field will open a search window that you 
can use to find a particular code.

Figure 8.  Search window
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New Patient Alert Code Messages screen
This screen will open when an alert is triggered for the patient.

Figure 9.  Patient Alert Message

When the alerts are displayed in the pop-up window, they display  in the order of the code field in 
the patient.

The message will show ALL of the alerts specified for that patient in that area. For example: if you 
have 2 alerts flagged to display in Transaction entry and 1 to display in appointments, when you 
launch transaction entry for that patient, you will see the 2 transaction entry alerts; you will not see 
the one flagged for the appointment. 

You have the option in certain places of deleting an alert from the patient’s record. When you click 
on an alert, it will turn Red to indicate which one is selected to delete. If you click on it again to de-
select it from deletion it will turn black again.  If there are no red items, the cancel button will be 
removed.

When you do, the Cancel button will appear at the bottom of the screen.

 • When you are done, click OK. Any codes you selected for deletion from the patient’s record will 
be deleted and you can continue your work.

Click Cancel if you have clicked on the X to delete and change your mind to keep the alerts in the 
patient’s record. Then, click OK to close the screen and continue your work.

Due to record-locking limitations, the Delete from Patient option on the pop-up window is not 
available when the pop-up displays when accessing the Patient or from Transaction entry.

Merge Patients

CGM highly recommends that you make a full backup prior to merging patients! In addition, be 
sure to process any Unprocessed Transactions for the patient whose record you are merging to 
another patient record. If you interface with an EHR, do not allow other users to add appointments 
for the source patient while a merge is in process. 

In addition, CGM recommends that:

 • No other users are accessing the source or target patient while the merge is in process.
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 • Close the Patient list and Office Hours prior to merging patients.

You can now merge two patient records if there are duplicates in your system. When you merge, 
the following data will be merged:

 • All Cases (and all information inside those cases including images) from the Move From 
(source) patient will be added to the Move Into (target) patient so that the Move To (target) 
patient has any original cases, as well as the ones added via the merge. 

Warning note: Potentially, now that cases have been moved, the ‘last used’ case on the 
Move To (target) patient will be different. 

 • Everything in Transaction Entry (all transactions--charges, payments, adjustments, 
statements, and claim notes, etc.) will now be associated with the Merge To (target) patient

 • All claims from the Move From (source) patient will now be associated with the Move TO 
(target) patient 

 • All Statements from the Move From (source) Patient will now be associated with the Move To 
(target) patient 

 • All appointments will be moved to the Move To (target) patient 

 • Phone numbers in appointments/recalls/waitlist: if the numbers in the most current 
appointment are the same as the numbers in the FROM patient, all appointments will have the 
number of the TO patient when merged.

 • If there are “one-off” phone numbers in the most recently added appointment of the FROM 
patient, where a number was changed in that appointment so it differs from the one(s) in the 
patient record, the merge will place that number in all appointments of the From patient once 
merged. The Waitlist and Recall will also have these number(s) after the merge. 

 • If there are no appointments for the FROM patient and the patient is on the Waitlist or has a 
Recall set and there are one-off numbers in FROM patient in Waitlist or Recall. after the merge 
the numbers in the Waitlist and Recall are left as they were entered in Waitlist and Recall on 
the FROM patient

 • All AR tracker items (tasks, status, notes, etc., will be moved).

 • All Archived records are merged

 • Final Draft: No changes will be made during the merge. 

 If you have any Final draft documents, you will need to manually change the file name of any 
documents saved with the From patient to the TO patient.

Final draft documentation Information or document text will NOT be changed during the 
merge. You must do this after the merge has taken place. 

 • If the Move From Patient (source) was a Guarantor or Policy Holder for any other patient, the 
Move To (target) patient will be replaced in those patients’ corresponding fields.

What will not be merged
Demographic data (name, address, telephone number, etc.) will NOT be moved between patients. 
The system assumes that the Move To patient's demographics are correct and the most current.
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It is recommended to do the merge when others are not using the system, However, if you do a 
merge while other users are in the system, you may encounter an error during the Merge because 
another user has a record in use/locked:

 • If there is an issue anywhere during the merge, you will need to fix the issue and start again. 
Otherwise, the Merge From patient will still exist and there will still be entries in tables not 
processed with the old patient until you finish the process.

Refresh
The Patient List and Office Hours grids do not refresh automatically after the merge. Consequently,, 
if someone is merging, other users may still see that patient on the list until they close and reopen 
the list. Be sure to instruct them to refresh the Patient List.

If the Patient List is open and cursor focus is on the move FROM patient and the user opens the 
Patient ledger, the ledger will open with the chart of the patient who is no longer there and the 
name of first patient in the patient list. In this case, simply pick another patient or close the list and 
reopen to refresh

Merging Patients and Interfaces with CGM MEDISOFT
If you are merging patients and use an EHR: CGM MEDISOFT does not send a Merge HL7 
message, so with some EHRs there is some pre- or post-work that needs to be done.  

For all EHRs: 

The CGM MEDISOFT Office side needs to communicate with the EHR side to no longer use the 
source patient to send charges.

If your EHR has a merge option, it should be done immediately after 
merging in Medisoft. No one else in the system should be doing any 
activities involving the Merge From or To patients while the merge is in 
process.

If your EHR does not have a merge option, mark the From patient inactive in the EHR or  do 
whatever process is applicable in that clinical system so that chart is no longer used to send 
charges

If there is a patient already in Unprocessed Charges before the merge, and then the merge is 
performed, the merge process will update the chart in Unprocessed with the Merge TO chart and, 
in most cases, will work as normal and can be posted. However, if the name, date of birth, or SSN 
are different between the patient in Unprocessed (the original FROM patient) and the current 
patient record (the Merged TO patient), there will be a mismatch error and that charge cannot be 
posted. That charge will have to be manually added in Transaction Entry and deleted from 
Unprocessed Transactions.

To avoid this, check Unprocessed Transactions prior to doing a merge and post the charges 
prior to the merge.

The most likely scenario for this is if there was a From patient who got married and the TO patient 
was added with the married/different name.
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Chapter 1 - Enhancements New Permission

The table below describes the steps to perform (if any) for each EHR.

New Permission
There is a new permission under Tools that you can set to control access to Merge Patients. 

Figure 10.  Medisoft Security Permissions

Interface Actions necessary

CGM APRIMA Use the Patient Merge feature in CGM APRIMA to merge the same two 
patients. For more information, see the CGM APRIMA Online Help topic 
“Merging Patient Records.”

CGM MEDISOFT 
EHR (Clinical) 

Use the Patient Merge feature in CGM MEDISOFT EHR (Clinical) to 
merge the same two patients. For more information, see the online Help 
topic in CGM MEDISOFT EHR (Clinical): “Merge Patients Utility.”

Plus Appointments/Demographics 

Nothing needs to be done. Any existing appointments for the FROM 
patient get updated with the TO patient and the highest case updates.

CGM MEDISOFT 
Mobile

CGM eMDs recommends that you do not do a merge while anyone is 
using these patients on a mobile device
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New menu option
There is a new option on the Tools menu: Merge Patients. Select this option to launch the merge 
patient process.

Figure 11.  Tools menu

New Merge Patient Warning message
This message reminds you of the changes to your patient records that will be made when you 
merge patients. Click Yes to proceed.

Figure 12.  Merge Patient Warning message
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New Merge Patient screen
Use this screen to select the patient records that you want to merge. 

 • In the Merge From Patient field, select the record that you want to be merged with the Merge 
Into Patient field. The Merge From Patient record will be DELETED when the process is 
complete. 

 • In the Merge Into Patient field, select the record that will receive data from the Merge From 
Patient record. This record will be RETAINED in CGM MEDISOFT after the process is 
complete.

Figure 13.  Merge Patient Utility screen

If you leave either field blank, you will receive an error message if you try to proceed.

Click Merge Now to merge the records. 

NOTE: CGM highly recommends that you make a backup BEFORE you merge records. In 
addition, process any Unprocessed Transactions for the FROM patient and close Office Hours. 

Move Charges
Transaction Entry has been updated so that you can move charges, copays, and fully‐applied 
patient payments from one case to another. You can choose specific charges from an existing 
source case and move it to a new target case without having to re‐key the transaction. This will be 
of help when patients change insurance and fail to tell the practice until after charges have been 
created in a case with the old insurance.

Important note: To use the Move Charges functionality, you MUST add the new grid column for 
the Move Charges check box to the Charges grid in Transaction Entry. For more information, see 
“New grid column”.
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Rules
The following rules apply to moving charges:

 • When Charges are selected to be moved to the target case, also move any patient payment 
that has been Fully applied to the charges being moved.  

 • Charges (and any associate claims or statements for these charges) and payments [patient 
payments only]) applied to these charges will be deleted from the source case once moved to 
the target case.  This is logged in the Audit report.

 • All fields (other than exceptions noted below) for the transactions that are being moved will 
move to the target case and remain the same on the new target case (Moved charges/
payments will keep the original document/ superbill numbers, original transaction Entry 
number, original Created date, etc.)  

 • If the charges to be moved have a claim associated, that claim number will not be transferred 
to the new target transactions. The moved charges will be eligible to be put on a new claim 
when claims are created. 

 • Claim Comment will be deleted from the source and NOT moved to the target.
 • Charges that have a zero amount Insurance payment (ex., in case of a Denial) applied to the 

source Case transactions can be moved to the target Case but the zero payment DOES NOT 
move to the target Case. 

 • If charges to be moved have a statement associated, that statement number will not be 
transferred to the new target transactions.

 • Statement Comment will be deleted from the source and NOT moved to the target

 • If the source Case had used custom Case fields or smart screens, data in that Case will not be 
touched.  When users move charges to the target Case, they will need to populate those again 
as needed.

 • If the source Case had used the UB-04, that will not be touched and will remain in the source 
Case.  When they move charges to the target Case the user will need to populate those again 
as needed.

 • Once the charge move has taken place, all behind the scene calculations in all needed tables 
will be updated to ensure both target and source Case balances are accurate.  

 • Visit Series: When moving charges from one Case to another, the following changes will be 
made to adjust the Visit Series information based on the move: On the From (source) patient, 
decrement the Last Visit Number and update Last Visit Date to the new actual last visit (if the 
last one is being moved).

 • On the To (target) patient Case: Increase the Last Visit number and update last visit if it was 
the last, based on the date of service. If the Authorized number of visits is blank, on the To 
(target) Case populate with 100 as it normally does when a new charge is added when there is 
no value. If there is already a number there, do not overwrite or change this value.  

 • If the move of charges takes the visits over the number in Authorized then start a new Series 
ID.  

Note: No other changes are made to the case itself other than above defined changes to the Visit 
Series.
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Limitations
The charges and patient payments applied to those charges will NOT be allowed to move in these 
scenarios and an error message will appear if they are encountered.

 • The Guarantor in the target Case is different from the source Case. 

 • If positive insurance payments or adjustments are applied to the source Case charges. 

 • If there are patient payments only partially applied to the charges.

 • If Document Number or Superbills are turned on you cannot move charges with the Show all 
box checked. 

Document numbers and Superbills
When you move charges, the original document or superbill number is moved with the charge if 
Program Options is set so that Document numbers or Superbills are being used at the top of 
Transaction entry:

Superbills

If one or more charges are tied to a superbill number, the superbill number moves to the Moved To 
case. If that case also had charges they will be on a different superbill number. You will need to 
select the Show all check box to see all of the charges (original and moved) displayed in the 
transaction grid.

To see each charge individually, you will select the superbill tied to that charge from the superbill 
field at the top of transaction entry. 

Document number

 • If the document number on the Move From case is the same as the document number on the 
Move To case, all charges will be seen in the transaction grid once you move them.  

 • If the document number on the move from case is different than the one on the charges on the 
Move To case, you will need to select the Show all check box to see all of the charges (original 
and moved) displayed in the transaction grid. 

 • To see each charge individually, you will select the document number tied to that charge from 
the Document number field at the top of transaction entry. 

$0.00 Insurance payments

When there is a $0.00 Insurance payment, CGM MEDISOFT will allow charges to move but the 
$0.00 insurance payment will remain on the original case. Consequently, CGM recommends that 
when you move a charge that has had a zero payment (as in a denial), be sure to add a note in the 
Description field of the payment that it was from a moved charge. In this way, later on you will know 
why the zero payment is there. 



CGM MEDISOFT 27
16 27 December 2022

New Permission Chapter 1 - Enhancements

New Permission
There is a new security permission under Enter Transactions for this feature: Allow Move Charges 
to New Case. Use this permission to set the access to this feature for users.

Figure 14.  Medisoft Security Permissions screen

Updated Add Fields screen
When you are modifying the grid columns that display in the Transaction Entry screen, there is a 
new field that you can select on the Add Fields screen: MoveCharges. 

Figure 15.  Add Fields screen

NOTE: you MUST add this field to display the corresponding column on the Transaction Entry 
screen to enable the Move Charges button. 
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New grid column
There is a new column you can add to the Charges section of Transaction Entry: Move Charges 
(MC). 

Figure 16.  Grid Columns screen

Updated Right-click menu 
When the check mark is selected for a charge in the Move Charges column, you can right-click and 
select Move Charges to open the Select Case to Move Charges To screen (for more information, 
see “New Select Case to Move Charges to screen” on page 18).

Figure 17.  Right-click menu

Note: you can select check boxes for multiple charges. In this case, you are indicating that you 
want to move the charges and copays from ALL these line items to another case.
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New Move Charges button
There is a new button in the Charge Entry section of the Transaction Entry screen: Move Charges. 
Click this button to move a charge or copay from one case to another case.

Figure 18.  Transaction Entry screen

Once you have selected the check box in the MC column, click the Move Charges. The Select 
Case to Move Charges to screen opens.

New Select Case to Move Charges to screen
This screen will open when you select the Move Charges button or the right-click menu for a 
selected charge. Use this screen to select the case that you want to move the charges and copays 
to. 

Figure 19.  Select Case to Move Charges to screen

Select a case and click the Move button to move the charges.

Procedures
To update the Charges Entry grid,

1. On the Activities menu, select Enter Transactions. The Transaction Entry screen opens.

2. In the Chart Number field, select a patient. 

3. Select a case.
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4. On the Charges grid, click the black dot at the top left corner. The Grid Columns screen opens.

5. Click the Add Fields button. The Add Fields screen opens. 

6. Scroll down to the MoveCharges field. Select it. Click the OK button. The Move Charges 
column header is added to the Grid Columns screen at the bottom

7. Use the Move Up button to move the column header to the place you want it in the grid. Click 
the OK button.

8. The Move Charges column header appears on the grid as MC.

To move a charge
To move a charge from one case to another,

1. On the Activities menu, select Enter Transactions. The Transaction Entry screen opens.

2. In the Chart Number field, select a patient. 

3. Select a case with charges already saved.

4. Select the check box in the MC column for the charge that you want to move to another case.

5. Click the Move Charges button (or the right-click option). The Select Case to Move Charges to 
screen opens.

6. Select the case.

7. Click the Move button.

Once the move is complete, the system remains on the source case, allowing you to move 
more charges from this case; or if you are finished, you can navigate to any other patient/case 
or close Transaction Entry as needed. 

Store PDF Documents
You can now save and store PDF files in a patient’s case. In addition, you can select to print a 
single image or multiple images stored in a patient’s case. 

Previously, if you received a PDF document, you couldn’t store it or view it in the Multimedia tab. 
Now, you can import that document easily and view it directly from the multimedia tab.

Updated Multimedia tab

Updated CGM MEDISOFT Advanced and Basic
You can now save multimedia images and files in the Patient Record in CGM MEDISOFT 
Advanced and Basic.
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Storage of PDFs
You can now import PDF documents to a patient’s record using the Multimedia tab using the Load 
From File button. These PDFs can be saved, displayed, and exported from the Multimedia tab. 

Figure 20.  Multimedia Entry screen

When you import a PDF, CGM MEDISODFT first converts the PDF file into a TIFF file. You will see 
a conversion Progress Bar while the conversion is occurring.

Figure 21.  Conversion Progress Bar

Once the image is saved, you can double-click it on the Multimedia tab to enlarge it for viewing.

Updated Multimedia Entry screen
You can now select to print either a single image or all pages of a multi-page document. 
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On the Multimedia tab, there is a new option that you will see when you select an image or images 
and click the Print button: Single image or All images.

Figure 22.  Multimedia Entry screen

Procedure

To Import a PDF
1. Open a patient’s case in Medisoft.

2. Select the Multimedia tab.

3. Click the New button in the left panel. The Multimedia Entry screen opens.

4. Click the Load From File button. 

5. Navigate to the folder where the PDF is stored.

6. Select the PDF and click the Open button. The PDF appears as an image on the Multimedia 
Entry screen. The first page appears in the center and other pages appear to the right.

7. Enter a Description, Note, and any other information.

8. Click the Save button. The PDF appears on the Multimedia tab. PDFs with multiple pages will 
show the first few pages and you can scroll down in the right panel to see the other pages.
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Office Hours
You can now add a facility to an appointment.

New Facility list

New menu item
There is a new menu item on the Lists menu in Office Hours: Facilities List. 

Figure 23.  Lists menu

New Facility List screen
Use the Facility List screen to create or view facilities from Office Hours. This accesses the same 
Facility List that is in CGM MEDISOFT.

Figure 24.  Facility List screen
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The table below describes the elements on this screen.

Element Description

Search for Enter a Code to search for. As you type 
characters, the grid will automatically filter. 

? button Click to open the Locate Facility Alert screen, 
which you can use for advanced searching.

Field Select the type of data to search for, either 
Code or Description

grid This shows you the list of facilities.

Edit button Click this button to edit a selected facility in the 
grid.

New button Click this button to create a new facility.

Delete button Click this button to delete a selected facility in 
the grid.

Print Grid button Click this button to print the information in the 
grid.

Close button Click this button to close the screen.
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Updated Appointment Entry screen

New field
There is a new field on the Appointment Entry screen: Facility.

Figure 25.  Appointment Entry screen

The facility selected here can be sent to CGM CONNECTION as part of that interface with CGM 
MEDISOFT. 
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Updated Appointment Information section
When the appointment is selected in the grid, the Facility selected for the appointment will appear 
in the left-hand section along with other appointment information.

Figure 26.  Appointment information display
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Updated Appointment List
You can now add Facility to the displayed columns on the Appointment List.

Figure 27.  Appointment List with Facility column

Updated Add Fields on the Grid Columns screen
Facility is now available on the Add Fields screen when you open the Grid Columns screen. 

Figure 28.  Add Fields in Grid Columns screen

Procedure
To add the Facility column to the Appointment List screen

1. In Office Hours, select Appointment List from the Lists menu. The Appointment List screen 
opens.

2. Click the black dot in the top left of the grid, to the left of the Name field. The Grid Columns 
screen opens.

3. Click the Add Fields button. The Add Fields screen opens.
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4. Select Facility and click the OK button. Facility is added to the Grid Columns screen. 

5. Use the Up and Down buttons to move Facility to the column position you want.

6. Click the OK button. The Facility is added to the Appointment List screen.

Updated New/Edit Wait List Appointment screen
You can now include the Facility on the New/Edit Wait List Appointment screen. 

Figure 29.  New Wait List Appointment screen

Updated Grid Columns/Add Fields
You can now add the Facility column to the Wait List screen in the same way as the screens above.
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Updated Scheduled Appointments List (CGM MEDISOFT Core)
In addition to having the new Facility field on the Appointment List in Office Hours, the field is also 
available on the Scheduled Appointments screen for the patient. 

Figure 30.  Scheduled Appointments list

Updated Grid Columns/Add Fields
The Facility field is also available to be added to the Grid Columns screen for Scheduled 
Appointments using the Add Fields screen.

Note: These are the ONLY places that Facility has been added. There have been no changes to 
Office Hours grid views or Reports for Facility. The main use for adding Facility in this release is to 
allow the Facility to be sent to CGM CONNECTION.

Updated Data Transfer to CGM CONNECTION
The Facility that is part of the appointment will be sent to CGM CONNECTION.

Be certain to enter a Facility in the appointment if your reminder templates in CGM CONNECTION 
are constructed for a Facility. Be sure to review your templates to make certain you are utilizing the 
data tables actually being populated.

For those already using CGM CONNECTION, and using LOCATION in your reminder templates, 
follow the procedure below when upgrading to CGM MEDISOFT 27. 

1. When ready to upgrade, disable the CGM CONNECTION interface in CGM MEDISOFT.

2. Perform the upgrade.

3. Create and fill-in Facilities in existing appointments.

4. Update the template in CGM CONNECTION to use the Facility information now in LOCATION,

5. Re-enable the CGM CONNECTION interface in CGM MEDISOFT. This will re-synch the data 
between CGM MEDISOFT and CGM CONNECTION.

You can use the new list of appointments which includes the new Facility field to determine 
which appointments are lacking a Facility and need to be updated.) 
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Existing users of CGM CONNECTION may also want to revise their Rules in CGM 
CONNECTION to account for existing Providers who populated the CGM CONNECTION 
LOCATION table previously and are no longer needed/wanted. 

Updated Chart drop-down
Inactive Patients have an Inactive column in Chart drop-down in the appointment chart field 
appointment. 

Figure 31.  New Appointment Entry screen
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CGM CONNECTION

Updated CGM CONNECTION Configuration screen

New button
There is a new button on the CGM CONNECTION Configuration screen: Set Global Patient 
Preferences. Click this button to set global preferences for contacting patients.

Figure 32.  CGM CONNECTION Configuration screen
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New Set Global Patient Preferences screen
There are new options on this screen to allow you to set global patient contact preferences, 
enabling you to set preferences without having to do so for each patient individually. If you want all 
patients to have the same set of contact preferences, use the fields here to set them.

Figure 33.  Set Global Patient Preferences screen

Any choices made in the new global opt-in preferences will NOT change any existing preferences 
set for a patient if ANY of the contact preferences for the patient are anything other than Opt-Out or 
if the master opt-out check box for the patient has been checked (at the top of the Preference 
window.

CCRD (Co-Pay, Co-Insurance, and Remaining Deductible Results 
from eMEDIX)

For more information on eMEDIX, contact your CGM representative or you can visit: https://
marketplace.emds.com/partner‐‐eMEDIX‐5JE‐714ZM.html

If your practice uses eMEDIX for its eligibility requests, you will now see the following information 
displayed in the patient’s case - Policy 1 tab, the sidebar in Office Hours when a patient 
appointment is selected, and in Transaction Entry.

 • Co-Pay (from Eligibility Request)

 • Co-Insurance Percentage  (from Eligibility Request)

 • Remaining Deductible  (from Eligibility Request)

https://nam04.safelinks.protection.outlook.com/?url=https%3A%2F%2Fmarketplace.emds.com%2Fpartner--eMEDIX-5JE-714ZM.html&data=05%7C01%7Cpash%40emds.com%7C1187b135548c491cbd7908da869a192d%7C9de90156a85648e5a8cdae5498ed702b%7C0%7C0%7C637970293665986327%7CUnknown%7CTWFpbGZsb3d8eyJWIjoiMC4wLjAwMDAiLCJQIjoiV2luMzIiLCJBTiI6Ik1haWwiLCJXVCI6Mn0%3D%7C3000%7C%7C%7C&sdata=o2qJ5zkzJtpT36Vps7HfzqJ3bmG1GX9yz4qmSarLuQM%3D&reserved=0
https://nam04.safelinks.protection.outlook.com/?url=https%3A%2F%2Fmarketplace.emds.com%2Fpartner--eMEDIX-5JE-714ZM.html&data=05%7C01%7Cpash%40emds.com%7C1187b135548c491cbd7908da869a192d%7C9de90156a85648e5a8cdae5498ed702b%7C0%7C0%7C637970293665986327%7CUnknown%7CTWFpbGZsb3d8eyJWIjoiMC4wLjAwMDAiLCJQIjoiV2luMzIiLCJBTiI6Ik1haWwiLCJXVCI6Mn0%3D%7C3000%7C%7C%7C&sdata=o2qJ5zkzJtpT36Vps7HfzqJ3bmG1GX9yz4qmSarLuQM%3D&reserved=0
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This newly displayed information may be more current than what was scanned from the card on file 
or manually entered. If the eligibility response co-pay is different than what was entered by your 
users, it is highlighted for your review.

CGM MEDISOFT will parse and display results for Individual (IND) in EB02 (Benefit Coverage 
Level Code) when available. If Individual is not available, then CGM MEDISOFT will parse the 
results as follows:

For Remaining Deductible if IND is not populated:

 • if there are results with EB02 blank, CGM MEDISOFT will select it.

For Copay or Coinsurance: 

 • If IND is blank, CGM MEDISOFT will select the first result with any value in EB02 (Family/
Employee/Spouse, etc) 

On Medicare results we will exclude Medicare Part A for all values.

The system will always parse and display In-Network coverage (not Out-of-Network).

For this feature, several updates have been made to CGM MEDISOFT.

Updated Program Options

New fields on Data Entry tab
There are three new fields for Service Type Code Priority Preferences, as well as a check box to 
indicate Specialist.

Figure 34.  Program Options - Data Entry tab
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There is no lookup provided for the codes. The Service Type Code fields can be alphanumeric with 
a maximum length of 3 characters. You must obtain the Service Type Codes from your own 
search. A possible source is:  https://x12.org/codes/service-type-codes

The new Specialist check box will be used by the practice if you wish the Co-Pay amount to be 
parsed from the 271 Eligibility Response for a Specialist (if it is returned), not a Primary Care 
Provider. With this box checked, CGM MEDISOFT will ALWAYS attempt to parse the Specialist Co-
Pay from the EB01 B segment that has a message segment indicating specialist.

Rules

 • If you have completed any of these new Service Type Code fields, when the 271 Eligibility 
Response if received, CGM MEDISOFT will parse and display the results for the 1st Service 
Type Code chosen.

 • If there are no results from the first Code, it will parse and display the results from the 2nd 
Service Type Code.

 • If there are no results to parse from the 1st or 2nd Codes, then CGM MEDISOFT will parse 
and display the results from the 3rd Service Type Code.

 • If there are still no results obtained, then CGM MEDISOFT will parse and display the results 
from a “general” 30 Service Type Code.

 • If you have NO values entered for the Service Type Code fields, CGM MEDISOFT will return 
results for 30.

Important: If you have no value in Service Type Code 1 but STC 2 or 3 is populated, it will 
return results for 30. The system will NOT look in 2 or 3 if 1 is left blank!

 • If the Eligibility Responses return a 0.00 for the new fields, the system will display a value of  0 
or 0.00. 

 • If the Eligibility Responses return an empty value, it will display an empty value rather than a 
zero. 

There is a difference between having a zero Co-Pay, Co-Insurance, or Remaining Deductible 
and not having any data (empty) for a Co-Pay, Co-Insurance, or Remaining Deductible.

https://x12.org/codes/service-type-codes
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Updated Case - Policy 1 tab
There are three new read-only fields on the Case - Policy 1 tab. These fields will display:

 • Co-Pay from Eligibility Request

 • Co-Insurance % from Eligibility Request

 • Remaining Deductible from Eligibility Request

Figure 35.  Case - Policy 1 tab

Note: The existing Copayment Amount field in the Policy 1 tab has no changes in this release and 
is not read-only. It can currently be manually entered, or an amount can be populated through an 
Acuant OCR scan of the patient’s insurance card.  

If the Co-pay amount returned from eMEDIX eligibility is different from the amount currently in the 
Copayment Amount field, the amount returned will appear in with a yellow highlight to notify you 
that you may want change the value in the existing Copayment Amount field.

Note that if a blank is returned, no value will  display;, if a 0.00 is returned, that will display.
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Updated Office Hours Left panel
Three new fields have been added to the bottom of the left panel and appear when an appointment 
is selected:

 • CoPay from Elig Request

 • Co-Ins % from Elig Req

 • Rem Ded  from Elig Req

Figure 36.  Office Hours Left panel

If the CoPay from eligibility request is different than the value in the existing CoPayment Amount 
field from the case used in that appointment, then Office Hours will display the value highlighted in 
yellow.

Note that if a blank is returned, a blank will display; in addition, if a 0.00 is returned, that will display.
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Updated Transaction Entry
Three new fields have been added to the Transaction Entry screen:

 • Co-Pay from Eligibility Request

 • Co-Insurance Percentage from Elig Request

 • Remaining Deductible from Eligibility Request

Figure 37.  Transaction Entry

If the CoPay from the eligibility request is different than the value in the existing CoPayment 
Amount field (from the case), then Transaction Entry will display the value highlighted in yellow.

Note that if a blank is returned, a blank will display; in addition, if a 0.00 is returned, that will display.

Unprocessed Transactions

Updated Grid Columns/Add Fields
You can now add a Source App column to the Unprocessed Charges screen. 

Figure 38.  Unprocessed Charges screen
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Updated Add Fields
The Source App column is now available on the Add Fields screen when you modify the displayed 
columns on the Unprocessed Charges screen.

Figure 39.  Add Fields screen

This column will show you the source of the transaction, either Other, Mobile, Plus, or CGM 
APRIMA. The table below shows the correspondence between the number in the Creating App 
column and the Name in the Source App column.

CGM APRIMA Interface

New fields
Several new demographic fields have been added to the CGM MEDISOFT to CGM APRIMA 
Interface. The information in these fields in the CGM MEDISOFT patient record will be transferred 
to CGM APRIMA. These include:

 • Birth Sex 

 • Gender Identity 

 • Sexual Orientation

To learn which versions of CGM APRIMA can accept the updates for the new demographic fields, 
always consult the latest CGM APRIMA Interface Guide, available on the VAR Portal.

Creating App Number Source App Name

0 Other (charges from CGM Practice 
Partner or charges from any external 
system prior to version 27)

1 Mobile

2 CGM PLUS

3 CGM APRIMA
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Final Draft
Final Draft has been updated for this release and you must open and save your template files. 
When you open a template file, you’ll receive a notice that you must save it.

Figure 40.  Error message

Line Spacing
With the update to Final Draft, the line spacing buttons in the toolbar will update the spacing both 
above and below the line the cursor was on when the spacing button was clicked. Previously, the 
spacing button would affect only lines below the cursor. 

This will affect both new and existing documents. 
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Below are a list of issues that were resolved with this release. 

Resolved Issues
The following issues were resolved with CGM MEDISOFT Release 27.

PBI Application Description

68843 UB-04 Claims The pagination displayed on UB-04 forms is now correct. A 
claim will no longer display the wrong number of pages for long 
claims.

Steps to recreate

1. In CGM MEDISOFT, create a case with 23 procedure 
transactions. 

2. Open Claims Management and print the claim to paper on 
a UB form.

3. Verify that the pagination reads 1 of 1.

68905 Medisoft Reports The Daily Activity Summary report will now print all pages. 
Previously, it would only print the first page.

Steps to recreate

1. In CGM MEDISOFT, select Reports > Medisoft Reports.

2. Run the Daily Activity Summary for enough days for 
multiple pages.

3. Print the report and verify that all pages print.

68979 Patient/Guarantor 
Ledger

Pressing the F5 key in Patient or Guarantor Ledger with 
Transaction Entry open will now open the note associated with 
the patient or guarantor in the Ledger rather than the note in 
Transaction Entry for the transaction selected.

Steps to recreate

1. In CGM MEDISOFT, open Transaction Entry.

2. Select a patient and click on a transaction to select it.

3. Open Patient Ledger and select a patient.

4. Press the F5 key and verify that the note associated with 
the patient in Patient Ledger opens.
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71033 Mediutils The Repair Practice Data tool in Mediutils will now repair or add 
the MWTEA (Transaction Entry Alert) table for a practice.

Steps to recreate

1. Open Mediutils and select Repair Practice Data.

2. Select Repair Practice Data and click the OK button.

3. Click Backup Data Now.

4. Create the backup and close the Back up screen.

5. Click Start on the Repair Practice Data screen.

71471 Cases When you load a multi-page document in Cases, you can now 
see all pages of the document. Previously, you could only see 
the first page.

Steps to recreate

1. In CGM MEDISOFT, open the case.

2. Select the Multimedia tab.

3. Click the New button. 

4. On the Multimedia Entry screen, select Load from File.

5. Select a multi-page Tiff document.

6. Click the Save button. Verify you can view all pages. 

80160 Medisoft Reports The Date From filter is now working for the Billing - Payment 
Status report in Medisoft Reports.

Steps to recreate

1. In CGM MEDISOFT, select Reports > Medisoft Reports.

2. Click the Medisoft Reports folder.

3. Double-click the Billing - Payment Status report.

4. Enter dates in the Date From and Date To fields.

5. Click the OK button. Verify that the report detail is correct.

94583 Archiving All charts and cases will now appear when archiving.

Steps to recreate

1. On the File menu select the Archive command. 

2. On the Confirm window click Yes to review the open cases. 
Verify that all cases appear.
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98765 Reports The Electronic Claims Analysis - Summary/Detail Reports will 
now generate properly.

Steps to recreate

1. On the Reports menu, select Analysis Reports, and then 
Electronic Claims Analysis, either Summary or Detail.

2. On the Print Report/Where? screen, click Start to preview 
the report to screen.

3. On the Filters screen, set your options and click OK.

4. Verify that the report prints. 

102709 When using the AR Write Off tool, CGM MEDISOFT will now 
populate the Date Created field for the adjustments in 
Transaction Entry.

Steps to recreate

1. In CGM MEDISOFT, open AR Tracker.

2. On the Filters screen, select Patient and set your 
parameters. Then, click the Apply button.

3. Select the Patient tab.

4. In the grid, right-click on the line item you want to write off.

5. Select Write-Off/Adjust.

6. Enter the information and click the Save button.

7. Go to Transaction Entry and verify there is a Date in the 
Date Created column. 
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01639420

/100030

You will no longer receive an error when editing/adding 
Supervising/operating Provider on case via OHP. 

Steps to recreate

1. Open Office Hours.

2. Create a New appointment.

3. Press F9 to edit the case.

4. Navigate to the Account tab.

5. Fill in a supervising provider.

6. Click Save.

7. Edit the case again.

8. Navigate to the Account tab again.

9. Select the Supervising Provider field.

10. Verify there is no error.

Note:

When adding a new case or editing a case from OHP and 
adding a new Supervising, Operating or Other Provider, 
Referral Source, Attorney there were other issues discovered: 

1 The new entry not automatically displaying in the case 
field after it has been added (fixed)

2. Newly added record not showing in the drop-down (fixed)

3 Window focus (not fixed; see below)

Since Supervising, Operating or Other Provider, Referral 
Source, Attorney are not part of Office Hours, if you edit or add 
a new case from an appointment and then do a new or edit for 
any of these on the Case Account tab, the window positions will 
not have the focus you would expect. Some windows will go 
behind others and or minimize. You will need to manipulate/ 
close windows manually if you use this process. The newly 
edited or added providers will be added with no error and will be 
refreshed and added to the drop-down so you can select them, 
but they will not be automatically populated as they are when 
doing these actions directly from the case. This process can be 
somewhat cumbersome so the best practice is to add these 
from the CGM MEDISOFT case directly.

https://nam04.safelinks.protection.outlook.com/?url=https%3A%2F%2Femds.my.salesforce.com%2F5005Y00001raesaQAA&data=05%7C01%7Cpash%40emds.com%7Cf040f32263514ba09dc508da73ef6126%7C9de90156a85648e5a8cdae5498ed702b%7C0%7C0%7C637949769247524536%7CUnknown%7CTWFpbGZsb3d8eyJWIjoiMC4wLjAwMDAiLCJQIjoiV2luMzIiLCJBTiI6Ik1haWwiLCJXVCI6Mn0%3D%7C3000%7C%7C%7C&sdata=irTp1nzo7ZWkXytPbUzybEn3eGH%2FY5hFjdl6M2UjCD4%3D&reserved=0
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69401 Referring Provider Referring providers created in Patient Quick Entry will now 
appear in the Referring Provider list. Previously, they appeared 
under Providers.

Steps to recreate

1. Set up a new Patient Quick Entry template that includes the 
Referring Provider field.

2. Create a new patient/ case using Patient Quick Entry.

3. In the Referring Provider field, right-click and choose New 

4. Create and save a referring provider.

5. Go to Lists, Provider, Providers.

6. Verify that the new referring provider does NOT appear.

7. Go to Lists, Referring Providers. Verify that the new provider 
appears here.

68920 Pending Patients Adding a patient from Pending patients will now add a Created 
Date to the Patient record.

Steps to recreate

1. Send an Intake from mobile to pending patients. 

2. Open Pending and create a case and save the patient. 
Verify that the patient record has a Created Date.

68948 AR Tracker Filter will no longer show all AR Status codes in the 
Patient AR Status drop down.

Steps to recreate

1. Open CGM MEDISOFT.

2. Open AR Tracker.

3. Click on Selected Filters and Options> Click to Change.

4. Click the drop down arrow in the Patient AR Status field. 
Verify that only Status codes set as Patient appear.
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